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General Provisions

Introduction

Optimal nesting of materials is the most important task of the procurement production. T-FLEX

Nesting program is an application for the T-FLEX CAD program and is designed to automate

a nesting of sheet materials for various types of nesting. The program accurately and quickly

calculates the parts nesting layout in such a way that the remnants of the material are minimal.

Nesting layouts can be exported as a T-FLEX CAD drawing and used to prepare programs for CNC

machines. For example, they can be used when working with the program T-FLEX CAM 2D, which

creates control programs for processing parts in two-dimensional geometry.

Example of true-shape nesting layout

The following types of material nesting exist in the T-FLEX Nesting:

· linear nesting - nesting of sheets in whips;

· guillotine nesting allows to obtain optimal nesting layouts of sheet material using through

cuts. The required parts can be a rectangle shape;

· true-shape nesting allows to obtain optimal nesting layouts of sheet material. The required

parts can be of any arbitrary shape.

The main criterion for optimization of the received nesting layouts is material utilization ratio, which

shows the production efficiency.
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Nesting can be used for various types of sheet materials:

· glass;

· metal;

· wood;

· plastics, etc.

The main users of the system are the following specialists:

Normer  - uses the product for normalization of the nesting operations. The main parameter is

material utilization ratio.

Technologist  - uses the product to obtain optimal nesting layouts and create a documentation.

Nesting Project Structure

The work in the program is carried out within the framework of the nesting project. The nesting

project combines the initial data, the nesting parameters and the results of the calculation of

the optimal nesting. The nesting project is created separately for each type of nesting. Set of

parameters and geometry differs for each of the project types.

T-FLEX Nesting Functionality

Hatch contours, downloaded from one or more T-FLEX CAD drawings, can be used in the program as

data for parts and sheets. Moreover, parts and sheets overall dimensions may be set manually in

the program interface. Number of parts and sheets in the project is not limited.

Sheets with defects may be set for the guillotine nesting in the program. A defect is a rectangular area

of a certain size and position on the sheet. The program performs calculation taking into account

the existing defects. It is possible to set a certain number of parts "to stock" for guillotine nesting

to provide a stock of the most demanded parts.
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You can setup general settings related to the calculation algorithm (part to sheet distance, part to part

distance, usable remnants sizes, allow parts inside other parts, solver optimization level, etc.) in

the project parameters.

As a result of the calculation the program generates:

· Layouts of optimal nesting with the ability to display cuts and material remnants, the value of

the material utilization ratio for each sheet. The resulting nesting layouts can be exported to

the T-FLEX CAD for further analysis and creation of documentation;

· Summary information about nesting: the number of specified and nested parts and used

sheets, the values of material utilization ratio and effective material utilization ratio taking into

account the usable remnants.

There is associative relation between the contours of parts and sheets in the nesting project and their

initial geometry in the T-FLEX CAD drawing. Due to this relations, the corresponding contours of parts

and sheets in the nesting project can be updated when changing the hatching contours in the drawing.

The update is done manually, which makes it possible to take into account changes in the original

geometry, when it is necessary.

The program allows you to save the nesting project in a separate file to allow subsequent use of

the nesting project data.

Comparison of T-FLEX Nesting functionality for different types of nesting:

Functionality Linear Nesting
Guillotine
Nesting

True-shape
Nesting

Initial data and nesting results

Nesting of long parts ("in whips")

Nesting of rectangle sheets

Nesting of arbitrary shape sheets

Manual addition of parts and sheets from T-FLEX CAD

interface

Loading parts and sheets from T-FLEX CAD (manually or

from a file)

Using of rectangle and arbitrary shape parts

Manual reallocation of parts on the nesting layout

Specify part to part distance for managing usable

remnants

Reports creation

Export of the nesting layout to T-FLEX CAD for

documentation creation
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Functionality Linear Nesting
Guillotine
Nesting

True-shape
Nesting

Nesting parameters

Parts rotation

Parts inside other parts

Accounting usable remnants

Assigning parts to stock

Accounting sheets defects

Strategies for parts layout on sheets

Terms and Abbreviations

Parts. In T-FLEX Nesting system parts are elements that should be placed on the sheets. For some parts

further processing after nesting may not be required. In this case such parts are semi-finished

products.

Nesting layout is the result of nesting parts on the sheets in the T-FLEX Nesting.

Nesting pattern is a technological document created on the basis of the nesting layout exported into

T-FLEX CAD.

Remains are everything that remains after the separation of parts from the sheet. There are two types

of remnants: waste (filings, small elements) and usable remnants that can be used in other nesting

projects.

Usable remnant - the term is used for production remnants, which can later be used for

the production of smaller parts. Dimensions of sheets to be considered as usable remnants are

assigned by the user.

Nesting "to stock" - is used for nesting an additional number of parts to provide a stock of the most

demanded items.

Utilization - material utilization ratio.

PC - product composition T-FLEX CAD.
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T-FLEX Nesting Fundamentals

Launching the Program

Running T-FLEX Nesting is carried out from the T-FLEX CAD program window. The program

commands are located on the Tools tab in the  Nesting.

Launching the T-FLEX Nesting program

For the legacy interface, start by using the Tools> Nesting> Project Window command.

Program Window

The program window consists of a toolbar and a workspace.

1 - Main Menu; 2 - Workspace

The Main menu contains commands for project and results management.

The File menu allows you to create, open, and save projects.



T-FLEX Nesting Fundamentals

9

The Results menu allows you to use the calculation results, in particular, to export nesting layouts to

the T-FLEX CAD.

The menu ? allows you to get help and information about the program.

The Workspace contains a set of tabs:

· The Parameters tab is intended for setting nesting parameters.

· The Parts tab is used to manage the list of parts for nesting and their parameters.

· The Sheets tab is used to manage the list of sheets and their parameters.

· The Layout tab contains the calculation results: preview of the optimal arrangement of parts

on the sheet and information on the results of nesting.

Saving of the Nesting Project

Project settings, lists and parameters of parts and sheets, as well as calculation results are saved for

a specific project and written to a file with the extension * .tfnesting.

Select File from the main menu. When saving for the first time, select Save As, specify the directory

and enter the filename, confirm the save. When you use the Save command, changes will be saved to

the current saved file.

To open the saved file select File > Open.

If you open another project, the current project will be closed. All unsaved changes will be lost.
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Nesting Parameters

The program allows you to create nesting layouts for different nesting types. To create a new project,

choose File > New from the document menu and specify the nesting type. The selected type

determines nesting parameters that are set on the Parameters tab.

Common parameters for all types of nesting include:

· Name - field for entering the name of the current project (user comment).

· Units - parameter for setting the units of measurement used in the project. It allows you to use

models that are created in different units. The units are taken into account when we import

and export data from and to T-FLEX CAD. I.e. if the project is in meters in T-FLEX Nesting , then

when you transfer data to T-FLEX CAD units will be converted to millimeters.

For Linear Nesting is characterized by the following parameters:

· Cutting Thickness - the gap between the parts as a result of the nesting.

· Part to Sheet Distance - the value of the minimum allowable distance between the edge of

the sheet and the contour of the part.

· Minimal Size of Usable Remnants - the smallest size of sheet remnants, which will be

considered to be usable remnants.

· Sheet Width - the width for all sheets in the project for the proportional display in the preview

window.

For Guillotine Nesting is characterized by the following parameters:

· Import Part Hatches from Layer - parameter for specifying the name of the layer, all hatches

from which will be imported to T-FLEX Nesting as parts. A layer with this name must be
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created in the T-FLEX CAD document, and all hatches for the nesting project should be placed

on it.

The parameters Cutting Thickness, Part to Sheet Distance, Minimal Size of Usable Remnants are

similar to the corresponding parameters of Linear Nesting.

For True-shape Nesting is characterized by the following parameters:

· Part to Part Distance - the distance between the parts to be cut.

· Part to Sheet Distance - minimum distance of parts from the edges of the sheet. If the sheet

has a cavity, then this space is also indented.

· Minimal size of usable remnants - the minimum size at which the remnant will be considered

usable. All the remnants are displayed on the nesting layout, and their sizes are displayed

when you hover the cursor. When changing the parameter value, the layout and information in

the reports are updated without recalculation.

· Layout Direction - parameter to select the direction for parts layout (Horizontal or Vertical).

· Start From - the angle from which the layout will start.

· Allow Parts Inside Other Parts. If the parameter is active, it is allowed to place small parts

inside large parts when nesting. Used to increase the value of material utilization ratio.



T-FLEX Nesting

12

Nesting layout with placement of small parts inside other parts

· Hold Remnents. Accounting for remnants in the project is optional. With this option enabled,

the reports will record remnants, the size of which is set by the Minimal Size of Usable

Remnants parameter. When the option is disabled, remnants is not recorded.

· Import Part/Sheet Hatches from Layer - the name of the layer, all hatches from which will be

imported to T-FLEX Nesting as parts/sheets. Layers with these names must be created in

T-FLEX CAD document and the corresponding hatches must be placed on them.
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The Accuracy group contains a set of parameters for controlling the Nesting layout:

· Solver optimization level. The value can be set from 0 to 100. The higher the value of

the parameter, the more variants for the estimated placement of the part the program will

calculate for achieving the optimal nesting, but the slower the calculation will be performed.

In most cases, a value from the range [5..20] is sufficient.

Nesting results at different optimization levels

· Rotation increment - step of the rotation angle of parts. The ability to rotate certain parts is

set on the Parts tab.
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Nesting results at different steps of the rotation increment

· Permitted Increase of Part to Part Distance - parameter that controls the degree of

approximation of the original geometry within the nesting project. For example, at a value

of 0 mm, the contour of the part will be used without approximation, regardless of

the simplification type set by user. In this case, the number of contour elements will be

maximum and will be equal to 150. When the value of the parameter is increased to 7 mm,

the contour of the part can be represented in the form of eight approximating segments. In

fact, the contour of the part, where the value of the parameter 7 mm is the maximum

deviation of the simplified geometry from the original contour, will participate in

the calculation.

Nesting results with different values of the permitted increase of part to part distance

The geometry is always approximated on the outer side of the contour without intersecting

the original one. The part becomes more simple, and the calculation is faster. The Permitted Increase

of Part to Part Distance parameter affects both the speed of calculation of the calculation and

the accuracy of the solution.
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Adding Parts

The program allows you to add parts of rectangle and arbitrary shape. The following ways of adding

parts the nesting project are possible:

· manually (parts are added one by one in the program interface);

· based on hatches (reading the hatch contours from the T-FLEX CAD drawings);

· from other projects created in T-FLEX Nesting;

· from external tables (multiple addition via the clipboard).

Supported shapes of parts and ways to set them:

Shapes of parts Ways of specifying parts

Nesting type:

linear* guillotine true-shape

Rectangle

manually

from external tables

based on hatches

Arbitrary shape

based on hatches

from product composition

* the width of the sheet is determined by the width of the part for linear nesting.

Part parameters are entered and edited on the Parts tab of the T-FLEX Nesting program window.

The use of arbitrary shape parts is allowed in the guillotine nesting. In this case, the overall dimensions

of the parts are taken into account.

For correct calculation it is recommended to use parts, the size of which is at least 1% of the

dimensions of the sheet.

Guillotine nesting for arbitrary shape parts
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Adding Parts Manually

To add a new part manually, there is the  [Add Part] button. Removing parts from

the list is carried out using the  [Delete Selected Parts] button.

Each part has a graphical representation in the right part of the window.

Adding Parts from T-FLEX CAD Drawings

There are two ways to read contours of hatches from a T-FLEX CAD drawing.

The described methods are not available for linear nesting.

Selective addition of parts from the active T-FLEX CAD document

Open the T-FLEX CAD document with the hatches, if you need to add particular contours of parts from

the drawing. Select the necessary parts (hatches) and in the context menu (or in the Tools tab of

the T-FLEX CAD program) select Add Part to Nesting Project. As a result, the entries for the added

parts will appear in the list on the Parts tab of the T-FLEX Nesting program.
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Adding parts from the T-FLEX CAD drawing

Part in the T-FLEX Nesting window
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In addition, you can add several selected parts or sheets at once using the appropriate commands in

the Ribbon panel.

After the command activation, you need select all the hatches to add to the project and click .

Adding all the parts from the T-FLEX nesting interface

Select the  [Import parts] option on the Parts tab to add all parts from

the drawing. Then select the T-FLEX CAD document, containing the parts for cutting, in the Open

dialog window. As a result, all the contours of the drawing hatches will be added to the T-FLEX

Nesting.

A T-FLEX CAD document can contain a large number of hatches, not all of which are contours for

parts. In this case, it is convenient to place the hatches for nesting on a special layer, for example,

"Nesting". If you click the [Import Parts] button, only the hatches belonging to this layer will be added

to the nesting project. The name of the layer is specified in the project in the Import Hatches from

Layer parameter.

If the hatch in the drawing is changed, it can be updated with the appropriate command from

the context menu.

Adding Parts from Created Projects

To add all parts from an existing nesting project, use the  [Import Parts] button on

the Parts tab. You need to specify the document type "T-FLEX Nesting project" in the appeared

window.

The parts existing in the current project will not be deleted. Parts imported from another project will

be added to the end of the list.

Adding Parts from External Tables

You can add parts to the Parts tab from external tables. 

First, you need to select the data in the table and copy it.
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Then go to the T-FLEX Nesting window on the Parts tab. Then call the context menu by clicking

the right mouse button in the Nesting window field. Select the Paste command in the context menu.

All the copied parts will be added to the table.

Example of adding multiple parts from the external table

In the external table, you can select not only values, but also column names.

In this case, after inserting a nesting into the project, the values are inserted into the corresponding

columns.

When inserting from external tables, it is important to consider the conditions described below:

· When copying only values, the order of their sequence is important.

· When copying values and column names, the order is not important.

For each project type, there is a minimum and maximum number of columns copied from the external

tables. If less data is copied from the table than required in the project, then this data will not be

added to the project. In other cases, the data is filled depending on the priority of the columns. 

Minimal required data from external tables for different types of projects.

Project type Length Width Quantity

Linear

Guillotine

True-shape

The maximum amount of data is different for each type of project. Boolean value types such as Allow

Rotation, Allow Mirror, Exclude from Nesting are not considered when pasting from external tables.

If the values are copied without headers, it is recommended to copy the minimum or maximum

number of columns with data for the current project.
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Adding Sheets

You can add sheets on the Sheets tab.

The blanks have the following parameters, similar to the parts parameters:

· Description;

· Part No;

· Material;

· Length, Width;

· Quantity;

· Exclude.

Adding sheets is similar to adding parts, except that the sheets can not be added from external

tables. 

To add a sheet from the CAD drawing, select Add Sheet in the nesting project in the hatch context

menu.

Use the Update button to update the sheet contour that was changed in the drawing.

For true-shape nesting the use of curvilinear sheets or sheets with cuts is possible. 

Sheets Defects

For guillotine nesting, it is possible to take into account defects on the sheets. By defining defects, you

can simulate chips, scratches, cuts, etc. Defects are set in the corresponding area on the Sheets tab.

A defect is a rectangular area that occupies a certain position on the sheets. The calculation is carried

out taking this area into account.

After creating a blank in the Defects block, use the  button (the  button is used to remove

defects from the list). In the Name field, enter the name of the defect (for example, "Chipped",

"Scratch", etc.) and specify the area of the workpiece in which it is located:

· X, Y. Specify the position of the defect. The origin of the XY coordinate system is the lower-left

corner.

· Width, Height. Specify the size of the rectangular area in which the defect is located.
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The Ignore Defects flag allows to ignore all defects specified for all sheets.

To set the defects, one or several sheets with defects must be picked out to a separate record. For

example, if one sheet of 9 sheets pack has defects, then we create a separate record for it, where we

specify the location and the size of the defects.

Specifying a defect on the sheet
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Automatic Data Generation Based on the Product Composition

The great advantage of the T-FLEX CAD system is the creation of parametric models. Also in T-FLEX

CAD there is a powerful system mechanism Product Composition, which collects data from

the model, filters and sorts them as needed. This mechanism is used to collect data about the product

composition and to generate the specifications. T-FLEX Nesting allows you to read data from the PC

automatically and to compose a nesting project.

The command for generation of nesting project on the basis of PC

A project is created for an active T-FLEX CAD document containing a special product composition

with parameters for T-FLEX Nesting. If the product composition changes as a result of model

reconstruction, then these changes will be reflected in the newly created nesting project. In that way

one of the most important and laborious tasks is solved: automatic generation of nesting project for

an order, whose composition is not defined when the assembly is created.

Order formation example

The mechanism for generating data for a nesting project based on the product composition is

presented on the example of the "Lid" model, which takes into account different options for creating

an assembly model, uses several materials and types of nesting of parts.
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The composition of the "Lid" model: 1 - casing; 2 - angle; 3 - decor; 4 - tag; 5 - rib

Assembly components are created in different ways: casing - a fragment that specifies the dimension

of the product; angle is inserted as the single fragment and is symmetrically copied to the other

corners; decor consists of four rectangular elements that are included into assembly as one adaptive

fragment; tag is a body created directly in the assembly; rib - an adaptive fragment, whose existence

in the assembly is determined by the height of the product (with a height of less than 250 mm, the rib

is automatically excluded from the composition of the model).

Product Composition Types for Nesting

Several types of product composition can be simultaneously created in one model to solve specific

tasks. Therefore, regardless of whether there is any type of PC in the model or not, it is necessary to

choose the appropriate type for nesting tasks. These PC types are installed with the T-FLEX Nesting

program.

Types of PC vary for:

· parts - type "Nesting. Part" is applied to all parts that require nesting;

· assembly units - type "Nesting. Assembly" is used in cases when it is necessary to create

a nesting project for an assembly unit or a product of a certain standard size in quantity of

one or several pieces;

· orders - type "Nesting. Order" is used in cases when it is necessary to form a nesting project

for assembly units or products of different standard sizes in required quantity.
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Product Composition Types for Nesting

When self-configuring the PC types for nesting, it is necessary to take into account the predefined

properties set used by T-FLEX Nesting, as well as the synonym names for them.

Settings
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If necessary, the names of the parameters can be adjusted. Synonyms can not be renamed.

Parameter Name Required parameters and its values Synonym Name

Element Type Yes (part, sheet, product) NestingElementType

Description No NestingName

Part No. No NestingNotation

Material No NestingMaterial

Length Yes (from hatch or explicitly) NestingLength

Width Yes (from hatch or explicitly) NestingWidth

Quantity in product No No synonym

Quantity of products No No synonym

Total number of parts Yes NestingCount

Nesting Type
Yes (linear, guillotine, true-

shape)
NestingType

For the automatic forming of PC in the assembly it is necessary to have completed data for each part.

In this case, the data in the PC of the assembly will appear automatically. It should be taken into

account that T-FLEX Nesting works with contours of parts based on hatches, therefore, the PC record

for the part is associated with the corresponding hatch. In this case, the dimensions of the part are

taken from the hatch geometry (Length and Width columns for them contain zero values). An

exception is the linear nesting type, where the dimensions of the part must be specified explicitly.

Also, if the detail has squared shape, then the hatch for it is not needed and the dimension can be

explicitly specified in the corresponding PC columns.
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The product composition for the "Casing" part 

If the required parameters for the parts are specified and the fragments embedding is set in the

assembly, the product composition of the assembly will be generated automatically.

Setting the embedding of fragments in the product composition
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The automatically generated product composition for an assembly unit

The parameters of the sheets can also be transferred to the appropriate section of the nesting project.

To do this, you need to set the appropriate nesting type for them.

To create an order, you can use either a special document prototype containing the necessary settings,

or follow the next sequence of actions:

· Create a new T-FLEX CAD document.

· Insert fragments with the required parameters.

· Create a new product composition type “Nesting. Order".

· Check the inclusion of fragments in the product composition by setting With Embedded

Elements:

· Apply the product composition representation and check the correctness of the data

generation for nesting:
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· Set the required products quantity for each standard size by sequentially changing

the calculating modes of the Quantity of Products column for the products:

If several nesting types are specified in the PC, then after launching the T-FLEX Nesting command

New > From Product Composition, a folder of the type <File name> _ <Nesting> is created where

the project files for the corresponding type are saved.

T-FLEX CAD documents used for creating of nesting project on the base of PC must be available

for the edit. Otherwise the system will give a notification message.
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After the project is formed, you need to set the project parameters and start the nesting optimization

in the T-FLEX Nesting.

The optimization results of true-shape nesting for the order
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Parameters of Parts and Sheets

An extended set of parameters for parts and sheets is displayed in a special dialog called from

the context menu of the selected record in the nesting project window.

You can select several parts at once and set common parameters for them. To do this, select

the details holding <Ctrl>.

There may be a situation where the source contour of the part has been changed. Parts whose

contours lost relevance will be highlighted in the project window in gray.

One of the following actions is required for out-of-date records: 

· Update using the context menu of the selected record; 

· Update using the button in the dialogue recording parameters;

· Delete the part and re-add it to the project.

If the contours of parts are not updated, changes in the contours of the parts will not be taken

into account when recalculating the nesting layout.
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You should first save the T-FLEX CAD document to be able to update changed contours.

Otherwise, links with the source contours can be lost.

General Tab

The following parameters are available for parts and sheets:

· Description. Specifies the name of the part/sheet.

· Part No. Specifies the part/sheet designation.

· Material. The field indicates the material of the part/sheet. Parts for which the material is

specified will be placed on sheets with the same material. Utilization ratio is calculated

separately for each of the materials.

· Length, Width. Specify the overall dimensions of the part/sheet. The Width parameter is not

specified for linear nesting (determined in the project parameters).

These parameters in the T-FLEX Nesting interface remain unchanged for parts and sheets

downloaded from T-FLEX CAD document drawings. Changing the dimensions of the part is

made in the drawing and can be updated in the part parameters. 

· Quantity. Number of parts/sheets of this type.

· Exclude part from Nesting. Allows you to ignore the selected parts/sheets in the calculation.

The following additional parameters are available for the parts:

· To stock. An additional number of parts that need to be nested apart from the number

specified in the Quantity field. Nesting to stock is made on the residual principle when

the main parts are placed on the sheet, and there is still enough material of the sheet for

nesting to stock.

To stock parameter can't be applied for the true-shape nesting.

· Color. Specifies the color of the part in the nesting layout.
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· Allow Mirror. Allows the turning of parts during the calculation of the cutting pattern.

· Allow Rotation. Allows you to specify rotation of part or group of parts in the plane of

the sheet.  For guillotine nesting - 90 degrees rotation; for linear - the rotation is specified by

the Rotation increment parameter in the project settings; for the linear nesting the rotation of

the parts is not provided.

Contour Tab

The Part / Sheet Contour tab contains auxiliary parameters:

· File. Contains the path to the T-FLEX CAD drawing from which the shading was loaded. The

[Browse] button allows you to select a directory for a file with the hatch manually.

· Hatch ID. Contains the hatch identifier from the T-FLEX CAD drawing. The Update button

allows you to take into account the modification of the part contour in the T-FLEX CAD

drawing and transfer the new width and length values to the T-FLEX Nesting project.

A set of Simplify Contour settings is used to simplify the spline geometry of the contours of parts,

allowing you to speed up the calculation:

· No - the calculation is made without simplifying the contour.

· Approximate by Straight Segments - replacement of the contour by linear segments.

· Approximate by Arcs – replacement of the contour by arcs.

· Replace by Rectangle - is used in those cases when the shape of a part is rectangular, and

possible cutouts or bevels should be ignored in calculation.

The degree of approximation of curvilinear contours of true-shape parts is specified by the Permitted

increase of part to part distance parameter on the Parameters tab for the true-shape nesting.

The number of approximating elements is determined automatically and is displayed in the Number

of contour segments field.
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Specifying of approximation for the contours of parts is also available in the dialog of parameters of

polygonal or curvilinear parts, as well as in their context menu.
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Performing the Calculation

Layout Tab

Select the  [Start Nesting] button on the Layout tab to start the calculation.

The calculation with a progress indication starts. You can cancel the calculation with the [Cancel]

button.

If there are no parts in the project or there is not a single sheet, the material of which

corresponds to the material of the part, the calculation will not be started and a corresponding

warning will appear.

The results of the calculation are the optimal nesting layouts for the sheets and the summary

information on the nesting (the number of specified and nested parts, the number of used sheets,

the value of material utilization ratio).

Information on the results will be provided in the respective columns after completion of

the calculation. The results are updated after each calculation.

Columns displayed in the window may differ depending on the type of nesting.

The window is divided into groups.

The Materials group displays information about all sheets of the same material:

· Description. Displays the name of the material, if it is specified.
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· Parts Nested. Displays the total number of parts and number of nested parts from

the specified material.

· Sheets Used. Displays the total number of sheets and number of used sheets from

the specified material.

· Parts Nested to Stock. Displays the number of parts nested to stock.

· Utilization. The column displays the utilization ratio of the material.

· Utilization Ratio. Displays Utilization with the Minimal size of usable remnants specified for

the project.

Parts with the same materials will be placed on the sheets with the same material.

The Sheets group displays information about the sheets. 

· Number. Displays the number of the sheet record in the table on the Sheets tab.

· Utilization. Displays the material utilization ratio of the sheet.

Under the Sheets groups is the Parts group. When selecting a part from the group all the parts of

the same type are highlighted on the nesting layouts. 

The nested sheets are listed in the order in which they were processed. 

The nesting layout of the selected workpiece is displayed to the right. To view several sheets at once,

select them by holding down the <Shift> key.

Nesting layout can be approximated and removed in the preview window by rotating the mouse

wheel, and moving in the preview window by holding the mouse wheel.
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Using the Show cuts  and Show offcuts  options you can display the cutting lines and sheet

remnants in the layout for linear and guillotine projects. Options are located in the upper left corner of

the preview window.

1 - cuts; 2 - remnants
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If the part for guillotine nesting is not rectangular, then the contour is displayed for it.

Reallocation of Parts for Guillotine Nesting

It is possible to manually reallocate the parts on the nesting layout for guillotine nesting. So, for

example, the user has the opportunity to select a part on the nesting layout and move it to a new

location. The part can be moved to any of the existing sheets, if there is a remnant sufficient for its

placement. You can reallocate one or more parts by highlighting them with <Shift>.

The item is selected at the first click . The second click you need to specify the remnant.

Manual reallocation of parts on the nesting layout:

a) The initial position of the part
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b) The new position of the part on the sheet
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Nesting Results Usage

Export Layout to T-FLEX CAD

The resulting nesting layout can be exported to T-FLEX CAD for designing nesting drawings. To do

this, select the  Export Layout to T-FLEX CAD command on the Layout tab. Set

the parameters for export of nesting layout in T-FLEX CAD in the appeared Parameters of Nesting

Layout Export dialog:

· Group Parts. All parts will be grouped after exporting to T-FLEX CAD. The group should be

exploded to edit the contour of a part in T-FLEX CAD.

· Create Hatches on the Parts. If the option is active, hatches will be created for the parts  in

T-FLEX CAD.

The hatch step is applied automatically when exported.

· Use Color of Parts. If the option is active, all parts will  be displayed in T-FLEX CAD in

the same color as in T-FLEX Nesting.

· Export Usable Remnants. If the option is active, then usable remnants will be unloaded into

the document.

· Create Hatches on Usable Remnants. If the option is active, hatching will be created for

the unloaded usable remnants.

· Create Dimensions. Dimensions will be created for all parts and sheets exported to T-FLEX

CAD. Quantity of parts and utilization ratio will be also displayed on the drawing. If the option

is not set, then the detail dimension will be displayed in the title block. When export a nesting

layout to T-FLEX CAD with the Create Dimensions option enabled, the dimensioning depends

on the Show Cuts option. If the display of cuts is enabled, then the dimensions are created on

them. If the option is disabled, the dimensions are created on the details. Depending on

the use of Create Dimensions option when exporting the nesting layout to T-FLEX CAD, part

number may change.
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Show Cuts disabled Show Cuts enabled

· Place Nesting Layouts on One Page.  It is convenient to use the option for exporting the linear

nesting layout, where  used sheets in "whips".

· Show Cuts. Graphic lines that show the location of the cutting lines will be created. The option

is available only for guillotine nesting projects.

· Number Identical Parts. All similar parts in the drawing will be numbered. The option is

available only for guillotine nesting projects.

· Use Template. You can select a document to create a nesting layout in the list: active

document or a standard prototype of the document.

The nesting layouts are placed on separate pages in the T-FLEX CAD document.
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Nesting layout, exported to T-FLEX CAD

Splitting of Sheet Remnants

Remains obtained on the sheet after true-shape nesting can be of irregular shape and inconvenient to

use. T-FLEX Nesting allows to divide the sheet remains into smaller elements that will be displayed in

accordance with the parameter Minimal Size of Usable Remnants. Smaller elements will not be

displayed.

To separate remnants, you must display the remnants using  Show Remnants option:
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After activating of  Split Remnants Manually option, you need to specify the splitting points:

The program creates cuts:
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Small elements (smaller than Minimal Size of Usable Remnants value) will be automatically hidden:

It is allowed to delete any any element by selecting it on the nesting layout and pressing the <Del>

key. Another displayed remnants are considered as usable remnants, which will appear in

the corresponding section of the reports:

Thus, the user has the opportunity to control the amount and form of usable remnants in real time. If

you change the value of Minimal Size of Usable Remnants, the remnants will be updated

automatically, without recalculating the project.

After recalculation of the nesting project the changes will not be saved. Therefore, the splitting

of remnants should be carried out only for the final nesting layout.
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Preparation of Documentation

If you want to prepare a document using the prototype of document with title block, it is convenient

to use the copying of the nesting layout with simultaneous scaling.

Copying of nesting layout

Inserting a nesting layout onto the pattern
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Ready Drawing

If necessary, you can choose the scale of the page for the nesting layout in the dialog ST: Set

Document Parameters on the Paper tab using the Scale parameter or by using the drop-down list in

the View panel.

Report Creation

To create a report, use the  Reports button on the Layout tab or select

Results > Reports.
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In the dialog that appears, on the General, Detailed Info and Remnants tabs, information on

the calculation results is provided.

Click the [Export] button to create a report. The report can be saved in the TXT, XML or XLSX formats.

The Clear result option is used when you need to clear result, for example, before sending by mail. 

Use Prototype for a Drawing Design

When using the active T-FLEX CAD document, the parameters of this document will be taken into

account as a prototype. It means that there will be similar fonts, thickness of lines etc. on new pages

with nesting layouts. Therefore, it is recommended to use similar projects to improve the convenience

of nesting layouts designing. It is possible, for example, to open in T-FLEX CAD an already designed

nesting layout with similar dimensions of the sheet as a prototype. The new layout will be generated

in a similar way, which will save time on designing of the drawing.

It should be noted that the nesting layouts are always exported to a new page, without affecting

the already existing drawings. Therefore, the page with the sample design can always be

deleted.
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